Introduction ............................................................. 1
Specifications ............................................................. 3
Hardware Setup .......................................................... 6
Preliminary Configuration through the CLI ...................... 10
Further Configuration through the Quick Start View .......... 14
Verifying the Configuration .............................................. 22
Shutting Down the WS 5100 ........................................... 24
Additional CLI Information ............................................ 26
Regulatory Information ................................................ 27
Part Numbers, Support, and Sales ................................. 29
Symbol Technologies, Inc. End-User License Agreement .... 31
1 Introduction

The Symbol WS5100 Wireless Switch is the high-performance member of Symbol’s WS5000 Series family. The WS5100, which is built on the same award-winning hardware and software architecture as the WS5000 platform, provides centralized Wireless LAN (WLAN) configuration and management by coalescing the network “intelligence” that was previously spread across physically distributed access points. By replacing access points with simpler access ports (or “thin” access points), the WS5100 becomes the single point of contact with the WLAN thus reducing, the complexity of wireless networking by moving management out of the ceiling and into the wiring closet. In addition, through the use of Symbol’s patented Virtual AP architecture, the WS5100 lets you create multiple WLANs without changing or adding to the existing wired network infrastructure.

This document is written for the network device installer.

1.1 Package Contents

Inspect the package contents and report any missing or damaged items to your sales representative. The package should contain the following:

- WS5100 Wireless Switch
- WS5100 Installation Guide (this document)
- Rack-mounting brackets (2)
- Mounting screws (4)
- Console cable
- WS5100 product CD

1.2 Document Conventions

The following graphical alerts are used in this document to indicate notable situations:

<table>
<thead>
<tr>
<th>Alert</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Checkmark] (NOTE)</td>
<td>Tips, hints, or special requirements that you should take note of.</td>
</tr>
<tr>
<td>![Exclamation Mark] (CAUTION)</td>
<td>Care is required. Disregarding a caution can result in data loss or equipment malfunction.</td>
</tr>
</tbody>
</table>
1.3  Warnings

- Read all installation instructions and site survey reports, and verify correct equipment installation before connecting the system to its power source.
- Remove jewelry and watches before installing this equipment.
- Install the equipment in a rack with adequate dimensions and weight allowances.
- Verify that the rack is anchored and cannot tip over or break away from its mountings.
- Verify that the unit is grounded before connecting it to the power source.
- Verify that any device connected to this unit is properly wired and grounded.
- Connect all power cords to a properly wired and grounded electrical circuit.
- Verify that the electrical circuits have appropriate overload protection.
- Attach only approved power cords to the device.
- Symbol Technologies strongly recommends the use of an Uninterruptible Power Supply (UPS) that supports the WS5100 power rating. Not using a UPS can result in data loss or equipment damage due to a power surge or power failure.
- Verify that the power connector and socket are accessible at all times during the operation of the equipment.
- Do not work with power circuits in dimly lit spaces.
- Do not install this equipment or work with its power circuits during thunderstorms or other weather conditions that could cause a power surge.
- Verify that there is adequate ventilation around the device, and that ambient temperatures meet equipment operation specifications.

1.4  Site Preparation

- Consult your site survey and network analysis reports to determine specific equipment placement, port capacity, power drops, and so on.
- Assign installation responsibility to the appropriate personnel.
- Identify where all installed components are located.
- Verify appropriate rack mounting requirements.
- Provide a sufficient number of power drops for your equipment.
- Ensure adequate, dust-free ventilation to all installed equipment.
- Identify and prepare Ethernet and console port connections.
- Verify that cable lengths are within the maximum allowable distances for optimal signal transmission.
- Verify that the WS5100 is powered through an Uninterruptible Power Supply (UPS).
2 Specifications

2.1 Physical Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>48.1 cm / 18.93 in. (with mounting brackets)</td>
</tr>
<tr>
<td></td>
<td>42.9 cm / 16.89 in. (without mounting brackets)</td>
</tr>
<tr>
<td>Height</td>
<td>4.39 cm / 1.73 in.</td>
</tr>
<tr>
<td>Depth</td>
<td>40.46 cm / 15.93 in.</td>
</tr>
<tr>
<td>Weight</td>
<td>6.25 kg / 13.75 lbs.</td>
</tr>
<tr>
<td>Max Power Consumption</td>
<td>100 VAC, 50/60 Hz, 3A</td>
</tr>
<tr>
<td></td>
<td>240 VAC, 50/60 Hz, 1.5A</td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>10°C - 35°C / 50°F - 95°F</td>
</tr>
<tr>
<td>Operating Humidity</td>
<td>5% - 85% without condensation</td>
</tr>
</tbody>
</table>

2.2 Power Cord Specifications

A power cord is not supplied with the device. Use only a correctly rated power cord that’s certified, as appropriate, for the country of operation.

2.2.1 Power Protection

- **If possible, use a circuit that is dedicated to data processing equipment.** Commercial electrical contractors are familiar with wiring for data processing equipment and can help with the load balancing of these circuits.
- **Install surge protection.** Be sure to use a surge protection device between the electricity source and the WS5100.
- **Install an Uninterruptible Power Supply (UPS).** A UPS provides continuous power during a power outage. Some UPS devices have integral surge protection. UPS equipment requires periodic maintenance to ensure reliability. A UPS of the proper capacity for the data processing equipment must be purchased.

2.3 Cable Requirements

To connect the WS5100 to the LAN and the WLAN, you’ll need two Category 6 Ethernet cables (not supplied), one for each of the two Ethernet ports on the front panel of the device.
To connect the WS5100 to a computer that’s running a serial terminal emulator program (the “configuration computer”), you need the console cable that’s supplied with the device. You’ll use the terminal emulator program to access the switch’s Command Line Interface (CLI) through which you’ll perform initial configuration (as described in “Preliminary Configuration through the CLI” on page 10).

2.4 LED Codes

The WS5100 has two vertically-stacked LEDs on its front panel. The LEDs display three colors (blue, amber, and red), and three lit states (solid, blinking, and off). The following tables decode the combinations of LED colors and states.

2.4.1 Start Up

<table>
<thead>
<tr>
<th>Event</th>
<th>Top LED</th>
<th>Bottom LED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Power On Self Test (POST) running</td>
<td>All colors in rotation</td>
<td>All colors in rotation</td>
</tr>
<tr>
<td>POST succeeded</td>
<td>Blue solid</td>
<td>Blue solid</td>
</tr>
<tr>
<td>Software initializing</td>
<td>Blue solid</td>
<td>Off</td>
</tr>
<tr>
<td>Software initialized</td>
<td>Blue blinking</td>
<td>Off</td>
</tr>
</tbody>
</table>

2.4.2 Configured as a Primary Switch

<table>
<thead>
<tr>
<th>Event</th>
<th>Top LED</th>
<th>Bottom LED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Blue blinking</td>
<td>Blue solid</td>
</tr>
<tr>
<td>Monitoring</td>
<td>Blue blinking</td>
<td>Amber solid</td>
</tr>
<tr>
<td>Standby missing or not enabled</td>
<td>Blue blinking</td>
<td>Off</td>
</tr>
<tr>
<td>Inactive</td>
<td>Amber blinking</td>
<td>Blue blinking</td>
</tr>
</tbody>
</table>

2.4.3 Configured as a Standby Switch

<table>
<thead>
<tr>
<th>Event</th>
<th>Top LED</th>
<th>Bottom LED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active (acting as primary)</td>
<td>Blue blinking</td>
<td>Blue blinking</td>
</tr>
<tr>
<td>Monitoring</td>
<td>Blue blinking</td>
<td>Amber solid</td>
</tr>
</tbody>
</table>
### 2.4.4 Error Codes

<table>
<thead>
<tr>
<th>Event</th>
<th>Top LED</th>
<th>Bottom LED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standby not enabled</td>
<td>Blue blinking</td>
<td>Off</td>
</tr>
<tr>
<td>Inactive</td>
<td>Amber blinking</td>
<td>Amber blinking</td>
</tr>
</tbody>
</table>

#### Note: During first time setup, the LEDs will remain in this state until the country code is configured.

<table>
<thead>
<tr>
<th>Event</th>
<th>Top LED</th>
<th>Bottom LED</th>
</tr>
</thead>
<tbody>
<tr>
<td>POST failed (critical error)</td>
<td>Red blinking</td>
<td>Red blinking</td>
</tr>
<tr>
<td>Software initialization failed</td>
<td>Amber solid</td>
<td>Off</td>
</tr>
<tr>
<td>Country code not configured.</td>
<td>Amber solid</td>
<td>Amber blinking</td>
</tr>
<tr>
<td>No access ports have been adopted</td>
<td>Blue blinking</td>
<td>Amber blinking</td>
</tr>
<tr>
<td>Primary inactive or failed</td>
<td>Amber blinking</td>
<td>Blue blinking</td>
</tr>
</tbody>
</table>
3  Hardware Setup

3.1  Installing the WS5100

To install the WS5100 switch in a rack:

1. Attach the rack brackets to the sides of the device. The rack brackets are ambidextrous.
2. Attach the brackets to the rack.

3.2  Adding the WS5100 to the Network

The WS5100 fits in the distribution layer of the existing wired network, and must have OSI Layer 2 connectivity with the access ports it needs to adopt. The following illustration shows the major components of a WS5100 network deployment.
As shown in the illustration, all wireless devices are connected to the WS5100 through **Switch A** and all wired devices are connected through **Switch B**.

To add the WS5100 to the wired and wireless networks, and prepare it for initial configuration, follow these steps:

1. Using a Category 6 Ethernet cable, connect a LAN switch (**Switch A**) to the **Eth1** Ethernet port (the left port) on the front panel of the WS5100.
2. Add your access port(s) to the WLAN.
3. Using a Category 6 Ethernet cable, connect another LAN switch (**Switch B**) to the **Eth2** Ethernet port (the right port) on the front panel of the WS5100.
4. Using the supplied console cable, connect the WS5100 serial port to an RS-232 (DB-9) serial port on a separate computer (the “configuration computer”).

5. On the configuration computer, configure a terminal emulation application (such as HyperTerminal) as follows:

<table>
<thead>
<tr>
<th>Terminal Type</th>
<th>VT-100</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>COM 1-4 (depending on which COM port you’re using.)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Terminal Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>19200 bps transfer rate</td>
</tr>
<tr>
<td>8 data bits</td>
</tr>
<tr>
<td>no parity</td>
</tr>
<tr>
<td>1 stop bit</td>
</tr>
<tr>
<td>no flow control</td>
</tr>
<tr>
<td>no hardware compression</td>
</tr>
</tbody>
</table>

The WS5100 does not need to be fully deployed into the wired or wireless network to complete the installation steps outlined in “Preliminary Configuration through the CLI” on page 10.

### 3.3 Supplying Power to the WS5100

1. Verify that the WS5100 power switch is off before connecting the AC power cord.
2. Plug an approved AC power cord into the power connector at the back of the WS5100.
3. Plug the cord into a standard AC outlet with a voltage range of 100 to 240 VAC.
4. Toggle the power switch (at the back of the WS5100) to the On position.

**WARNING!** An improper shutdown can render the WS5100 inoperable such that it may require service by Symbol Support. Please do not remove AC power or turn off the WS5100 (by toggling the on/off switch on the back of the device) without first following the shutdown procedure described in “Shutting Down the WS5100” on page 24. An abrupt loss of power can corrupt the information stored on the device.

### 3.4 Verifying the Installation

View the LEDs on the front panel of the WS5100 to ensure the device is functioning properly. The normal LED pattern follows this path:
During the Power On Self Test (POST), the two LEDs cycle through all three colors (blue, amber, red).

If the POST test fails, both LEDs will eventually blink red. If the POST test succeeds, the LEDs will be (momentarily) lit solid blue.

As the software is initialized, the top LED will be solid blue, and the bottom LED will be unlit.

After the software has finished initializing, the top LED will be solid amber, and the bottom LED will blink amber. The WS5100 is ready to be configured, as described in the next chapter.

Other LED codes indicate the presence (or absence) of access ports, different standby states, and so on. A guide to the WS5100 LEDs codes is provided in “LED Codes” on page 4.
4 Preliminary Configuration through the CLI

Most of the practical configuration of the WS5100 is performed through the **Quick Start View** applet. However, to access the applet you first have to use the Command Line Interface (CLI) to configure the Ethernet port that connects the switch to the wired LAN.

Before proceeding with the CLI instructions described below, connect a configuration computer to the WS5100, as described in “Adding the WS5100 to the Network” on page 6. Keep in mind the switch doesn’t have to be deployed into the network to perform this initial configuration.

4.1 Typographical Conventions

The following typographical conventions apply to the CLI examples:

- The CLI prompt and output are shown as *unbolded*.
- Text that you enter verbatim is **bold**.
- Values that you “make up” (as command parameters) are in *bold italics*.

For example:

```
ws5000.(Cfg).Ethernet.[2]>set gateway w.x.y.z
```

Here, everything up to and including the “>” is part of the CLI prompt; **set gateway** is a CLI command; *w.x.y.z* is a value you create (or otherwise obtain) as appropriate for your network.

4.2 Logging Into the CLI

After you’ve connected the WS5100 through the serial port and powered on the switch, the terminal emulation window displays a series of inscrutable diagnostic messages (which you can ignore), after which it will display the WS5000 Series user name prompt. Use the name cli to continue:

```
user name: cli
```

![NOTE] If the user name prompt isn’t displayed, press Enter until it appears.

Next, you’ll be taken to the CLI login. Log in as **admin** with the password **symbol**: 
Symbol Wireless Switch WS 5000 Series.
Please enter your username and password to access the Command Line Interface.

userid: admin
password: ******

Retrieving user and system information...
Setting user permissions flags..
Checking KDC access permissions...
Welcome...
Creating the Event list...
System information...
System Name                : WS5000
Description                : WS5000 Wireless Network
Switch Location            :
Software Ver.             : 2.1.0.0-0xxx
Licensed to                : Symbol Technologies
Copyright                  : Copyright (c) 2000-2006. All rights reserved.
Serial Number              : 00A0F8545254
Number of Licenses         : 48
Max Access Ports           : 48
Max Mobile Clients         : 4096
MU Idle Timeout value      : 1800 seconds
Active Switch Policy       : symbol2006
Emergency Switch Policy    : Not defined
Switch Uptime              : 00d:00h:35m
Global RF stats            : Disabled
# of Unassigned Access Ports : 0
CLI AutoInstall Status     : Enabled

WS5000>

Compare the value of the “Software Ver.” field to the value on the Symbol Website at:

http://www.symbol.com/services/downloads/download_switchwireless.html
If the Website software is newer (if the \texttt{2.x.y.z-nnnA} number on the Website is alphanumerically greater than your version), download and install the newer version by following the instructions on the Website.

4.3 Disable DHCP on the Wired LAN Port

To perform the initial configuration, disable DHCP on the Ethernet port that connects to the wired LAN. Connect to the LAN through either Ethernet port; by convention, and as used throughout this document, Ethernet port 2 is used as the wired LAN port.

By default, DHCP is enabled on Ethernet port 2. Disable DHCP on the port by entering the \texttt{Ethernet.[2]} context and issuing the \texttt{set dhcp disable} command:

\begin{verbatim}
WS5000>cfg ethernet 2
WS5000.(Cfg).Ethernet.[2]>set dhcp disable
\end{verbatim}

After you disable DHCP, information about Ethernet port 2 is listed. In this listing, \textbf{DHCP Status} should be given as \textbf{Disable}:

\begin{verbatim}
WS5000.(Cfg).Ethernet.[2]> set dhcp disable
Configuring Ethernet port...
Status: Success.

Ethernet Port information:
Name : Ethernet 2
Network Interface Card # : 2
Description : Ethernet Adapter
MAC Address : 00:10:C6:15:91:1F
Status : Enable
Online : No
Configured Mode : auto
Negotiated Mode - Duplex : Half
Negotiated Mode - Speed : 10
DHCP status : Disable
WS5000.(Cfg).Ethernet.[2]>
\end{verbatim}

4.4 Set Static IP Information on the Wired LAN Port

Within the \texttt{Ethernet.[2]} context, use the \texttt{ipaddress} command to set the static IP address and subnet mask (in that order):

\begin{verbatim}
WS5000.(Cfg).Ethernet.[2]>ipaddress w.x.y.z 255.d.e.f
\end{verbatim}
Next, set the gateway and DNS server addresses:

\[\text{WS5000.\text{(Cfg).Ethernet.}[2]\text{>set gateway a.b.c.d}}\]
\[\text{WS5000.\text{(Cfg).Ethernet.}[2]\text{>set dns m.n.o.p}}\]

After each of these commands, information about the context is displayed. Check the IP address settings to make sure they’re correct.

At this point, the initial configuration of the WS5100 is complete. Continue the configuration through the switch’s Web-based applet interface, as described in the next section.
5  Further Configuration through the Quick Start View

To complete the initial configuration of the WS5100, use the Quick Start View. The Quick Start View is part of the WS5000 Series applet, a Web-based tool that lets you configure your WS5100 switch through an intuitive graphical interface. The Quick Start View portion of the applet is designed to take a factory-fresh switch and bring it up to a minimal working configuration. For advanced switch configuration, refer to the WS5000 Series System Reference, which you’ll find on the product CD.

Using the instructions below, create a WLAN policy and a security policy. You’ll then apply these policies to the WS5100 switch policy. After you’ve created and applied the policies, you should be able to adopt and communicate with properly configured mobile units, as described in “Verifying the Configuration” on page 22.

5.1  Applet Requirements

The WS5000 Series applet is accessed through Internet Explorer version 5.5 using the SUN JRE (Java Runtime Environment) 1.4.2_04. (Later versions of IE and the SUN JRE are also supported.) A copy of the SUN JRE is provided with your WS5100 product CD. To install the JRE, insert the CD, wait for the Flash menu to appear, and then select Install the SUN JRE.

To prepare Internet Explorer to run the WS5000 Series applet:

1. Open IE’s Tools > Internet Options panel and select the Advanced tab.
2. Uncheck the following checkboxes:
   - Use HTTP 1.1
   - Java console enabled (requires restart)
   - Java logging enabled
   - JIT compiler for virtual enabled (requires restart)
5.2 Launching the Quick Start View

To use the Quick Start View, launch a Web browser on a computer that can access your WS5100.

1. Point the browser to the IP address you assigned to the wired Ethernet port (port 2) in “Set Static IP Information on the Wired LAN Port” on page 12. Specify a secure connection using the \texttt{https://} protocol.

The WS5000 login screen displays:

![Login Screen](image)

2. Enter the User ID \texttt{admin}, and Password \texttt{symbol}. Both are case-sensitive.
3. Click Login. The WS5000 Switch Policy window appears.
4. From the main menu, select **View > Quick Start.** The **WS5000 Quick Start View** window appears. Use this window to create the WLAN policy and apply it to the WS5100.

5. In the **Switch Settings** form, set the **Country** to the country the switch is operating in, leave **Warm Standby** as **Primary,** and set the various date and time parameters.

---

**CAUTION** The switch can’t adopt access ports until the country code is set. Failure to set the proper country could violate regulatory laws.
6. In the **WLAN #1** form (in the lower half of the window), set the **ESSID** to a unique value (MyWLAN in the example), set the **Bandwidth** to **100** and set the **LAN** to **Ethernet 1**.

Make a note of the ESSID value, you’ll need it later when you verify the configuration.

7. In the lower part of the **WLAN #1** form, set **Encryption**: to **WEP**, set **Authentication**: to **Pre-Shared Key**.
8. Click the Configure button next to the WEP radio button. The WEP Encryption Key Settings dialogue panel is displayed.

![Security Policy Wizard]

9. Select the Key Size. This can be either a 40bit key or 128 bit hex key. Once you have selected the key size, enter the Pass Key. The Pass key should have a minimum of 4 characters. Click the Generate button to generate the 4 Key # feilds.

![Security Policy Wizard]

10. After you’ve recorded your key values, click Save at the bottom of the dialogue.
11. Back in the **WS5000 Quick Start View**, click **Apply** to save the configuration.
12. An information panel appears; click OK.

**NOTE**  Your new configuration is not displayed in the Quick Start View. To view the policy you just created, you have to go to the View > Policy window. The policy is given a default name that corresponds to WLAN #1.
6 Verifying the Configuration

The surest way to verify your WLAN configuration is valid and that the switch is fully operational, is to associate a mobile unit (MU) and confirm that the MU can communicate with a device on the wired LAN. Follow these steps:

1. Deploy the WS5100 into the wired and wireless networks by connecting the Ethernet cables as described in “Adding the WS5100 to the Network” on page 6.

2. Identify, by IP address or host name, a computer the WS5100 can communicate with over the wired LAN. This is the device the MU will try to communicate with later in these instructions.

3. Make sure an access port has been adopted by the WS5100.

4. Configure the MU with the same ESSID (MyWLAN) and WEP encryption settings that you used in the Quick Start View configuration.

5. After you’ve configured the MU, verify that it has been associated by the returning to the Policy View screen and clicking Mobile Units. The MU View should have an entry that identifies your mobile unit and shows the RF State as Associated. If it doesn’t, check the ESSID and encryption settings are properly set on the MU.

```
<table>
<thead>
<tr>
<th>MU Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>WLAN: All WLANs</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type</th>
<th>MAC Address</th>
<th>IP Address</th>
<th>WLAN</th>
<th>RF State</th>
<th>Authentication State</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>00:A0:F8:A7:44:DE</td>
<td>2.2.2.211</td>
<td>Q1WLAN01</td>
<td>Associated</td>
<td>Authenticated</td>
</tr>
</tbody>
</table>
```

MU Count: 1
6. If you want more information, select the mobile unit and click Properties. The MU Properties dialogue displays everything the switch knows about your mobile unit.

7. Finally, verify the WS5100 is fully operational on both sides of the network (wired and wireless) by pinging the device on the wired LAN from the MU. If the wired device responds, the switch is working. If it doesn’t respond, make sure the wired device is on, it’s on the proper LAN, and you’re pinging the correct IP address or host name.
7 Shutting Down the WS5100

To gracefully shutdown the WS5100, issue the `shutdown` command from the `configure` context in the CLI:

```
WS5000.(Cfg)> shutdown
This command will halt the system.
A manual power cycle will be required to re-start the switch.
Do you want to proceed (yes/no) : yes

System shut down might take a few mins....
Shutting down the switch...
Shutting down dhcp daemon.. done
Shutting down apache server in the OPEN mode...done.
Shutting down cell controller........ done
Shutting down snmpd agent...done.
Shutting down Postgres....done.
INIT: Sending processes the TERM signal
Shutting down PacketSwitch interface .......
Shutting down dhcp daemon.. done
Shutting down dhcp daemon server in the OPEN mode...done.
Cell controller not running.
i2c-core: Device or resource busy
Shutting down Postgres....done.
Stopping periodic command scheduler: cron.
Stopping internet superserver: inetd.
Saving random seed... done.
Stopping deferred execution scheduler: atd.
Stopping kernel log daemon: klogd.
Stopping system log daemon: syslogd.
flushing ide devices: hda
System halted.
As directed, wait 10 seconds and turn off the device by toggling the power switch.

**WARNING!** An improper shutdown can render the WS5100 inoperable such that it may require service by Symbol Support. Please do not remove AC power or turn off the WS5100 (by toggling the on/off switch on the back of the device) without first following the shutdown procedure outlined above. An abrupt loss of power can corrupt the information that’s stored on the device.
8 Additional CLI Information

8.1 CLI Contexts

At each step of the configuration, you’ll be asked to invoke CLI commands within a particular “context.” To enter the main “configuration” context, type `configure` at the top-level CLI prompt. The prompt changes when you change contexts:

```
ws5000> configure
ws5000.(Cfg)>
```

All of the contexts in the following instructions are “subcontexts” of the `configure` context. For example, to get to the WLAN context you would type `wlan` within the `configure` context:

```
ws5000.(Cfg)> wlan
ws5000.(Cfg).WLAN>
```

As a shortcut, jump directly to a configuration subcontext through the “`configure subcontext`” command:

```
ws5000> configure wlan
ws5000.(Cfg).WLAN>
```

As a further shortcut, the CLI performs silent auto-completion of unambiguous commands. As an example, “`conf`” is a sufficient abbreviation for “`configure`”. If you enter an abbreviated command that isn’t unambiguous (i.e. that can resolve to more than one command), you’ll be presented with a list of command completions.

---

**NOTE** All CLI commands are case-insensitive. All user-created data (the name you give a policy that you create, for example) is case-sensitive.

---

8.2 Common CLI Commands

Within any context, you can:

- List all the available commands by typing `help` or `?`
- Show the current configuration settings by typing `show`.
- Bump up one configuration context level by typing `..` (two periods).
- Get back to the top-level context by typing “`exit`”.

9 Regulatory Information

WARNING! This regulatory section applies only to the WS5100 device (WS-5100-Rxx-xxx-WR). For more details refer to "Part Numbers, Support, and Sales". All Symbol devices are designed to be compliant with rules and regulations of locations they are sold in and are labeled as required.

Any changes or modifications to Symbol Technologies equipment that are not expressly approved by Symbol Technologies are possibly unsafe and could render the equipment inoperable.

CAUTION This is a class A product. In a domestic environment this product may cause radio interference in which case the user may be required to take adequate measures.

Radio Frequency Interference Requirements - USA

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Radio Frequency Interference Requirements - Canada

This Class A digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

Marking and European Economic Area (EEA)
Statement of Compliance

Symbol Technologies, Inc., hereby declares that this device is in compliance with all the applicable Directives, 89/336/EEC, 73/23/EEC. A Declaration of Conformity may be obtained from:

http://www2.symbol.com/doc/
10 Part Numbers, Support, and Sales

Part Numbers

<table>
<thead>
<tr>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>6-port WS5100 Wireless Switch</td>
<td>WS-5100-R210-06-WR</td>
</tr>
<tr>
<td>12-port WS5100 Wireless Switch</td>
<td>WS-5100-R210-12-WR</td>
</tr>
<tr>
<td>18-port WS5100 Wireless Switch</td>
<td>WS-5100-R210-18-WR</td>
</tr>
<tr>
<td>24-port WS5100 Wireless Switch</td>
<td>WS-5100-R210-24-WR</td>
</tr>
<tr>
<td>30-port WS5100 Wireless Switch</td>
<td>WS-5100-R210-30-WR</td>
</tr>
<tr>
<td>36-port WS5100 Wireless Switch</td>
<td>WS-5100-R210-36-WR</td>
</tr>
<tr>
<td>42-port WS5100 Wireless Switch</td>
<td>WS-5100-R210-42-WR</td>
</tr>
<tr>
<td>48-port WS5100 Wireless Switch</td>
<td>WS-5100-R210-48-WR</td>
</tr>
<tr>
<td>Redundant WS5100 Wireless Switch</td>
<td>WS-5100-R210-RS-WR</td>
</tr>
<tr>
<td>6-port Upgrade</td>
<td>WS-5100-UC-WW</td>
</tr>
</tbody>
</table>

Symbol Support Center

Use the Symbol Support Center as the primary contact for any technical problem, question, or support issue involving Symbol products. Symbol Support Center responds to calls by email, telephone or fax within the time limits set forth in individual contractual agreements:

- Telephone (North America): 1-800-653-5350
- Telephone (International): +1-631-738-6213
- Fax: (631) 738-5410
- Email: support@symbol.com

When contacting Symbol Support Center, please provide the following information:

- Serial number of the unit (this is the same as the MAC of NIC 1).
- Model number or product name.
- Software type and version number.
Customer Support Web Sites

Comprehensive on-line support is available at the MySymbolCare Web site. Registration is free and a variety of services can be linked through this Web portal.

- MySymbolCare for RMA Requests: http://www.symbol.com/services/msc/msc.html
- Symbol Services Homepage: http://www.symbol.com/services
- Symbol Software Updates: http://www.symbol.com/services/downloads
- Symbol Developer Program Web Site: http://devzone.symbol.com

Product Sales and Product Information

<table>
<thead>
<tr>
<th>North America</th>
<th>International</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol Technologies, Inc.</td>
<td>Symbol Technologies, Inc.</td>
</tr>
<tr>
<td>One Symbol Plaza</td>
<td>Symbol Place</td>
</tr>
<tr>
<td>Holtsville, New York 11742-1300</td>
<td>Winnersh Triangle, Berkshire, RG41 5TP</td>
</tr>
<tr>
<td>Tel: 1-631-738-2400 or 1-800-722-6234</td>
<td>United Kingdom</td>
</tr>
<tr>
<td>Fax: 1-631-738-5990</td>
<td>Tel: 0800-328-2424 (Inside UK)</td>
</tr>
<tr>
<td></td>
<td>+44 118 945 7529 (Outside UK)</td>
</tr>
</tbody>
</table>

Other Sales Offices

For other sales offices visit the Symbol Services Web site:

http://www.symbol.com/services/howto/howto_contact_us.html

General Information

For general information, contact Symbol at:

- Telephone (North America): 1-800-722-6234
- Telephone (International): +1-631-738-5200
- Website: http://www.symbol.com

CAUTION: This is a class A product. In a domestic environment this product may cause radio interference in which case the user may be required to take adequate measures.
11 Symbol Technologies, Inc.
End-User License Agreement

BY DOWNLOADING, INSTALLING, OR USING THE SOFTWARE DESCRIBED IN THIS DOCUMENT, YOU OR THE ENTITY OR COMPANY THAT YOU REPRESENT ("LICENSEE") ARE UNCONDITIONALLY CONSENTING TO BE BOUND BY AND ARE BECOMING A PARTY TO THIS LICENSE AGREEMENT ("AGREEMENT"). LICENSEE'S USE OR CONTINUED USE OF THE DOWNLOADED OR INSTALLED MATERIALS SHALL ALSO CONSTITUTE ASSENT TO THE TERMS OF THIS AGREEMENT. IF LICENSEE DOES NOT UNCONDITIONALLY AGREE TO ALL OF THE TERMS OF THIS AGREEMENT, DO NOT CONTINUE THE INSTALLATION PROCESS. IF THESE TERMS ARE CONSIDERED AN OFFER, ACCEPTANCE IS EXPRESSLY LIMITED TO AND EXPRESSLY CONTINGENT UPON THESE TERMS. IF YOU ARE ACCEPTING THESE TERMS ON BEHALF OF A COMPANY, ANOTHER PERSON OR ANY OTHER LEGAL ENTITY, YOU REPRESENT AND WARRANT THAT YOU HAVE THE AUTHORITY TO BIND THAT COMPANY, PERSON OR ENTITY.

1 LICENSE GRANT. Subject to the terms of this Agreement, Symbol Technologies, Inc. and/or its subsidiaries ("Licensor") hereby grants Licensee a limited, personal, non-sublicensable, non-transferable, nonexclusive license to use the software that Licensee is about to download or install and the documentation that accompanies it (collectively, the "Software") for Licensee's personal use in connection with hardware produced by Licensor and only in accordance with the accompanying documentation. Licensee may download, install and use the Software only on a single computer. Licensee may make one copy of the Software (excluding any documentation) for backup purposes, provided that copyright and other restricted rights notices of Licensor and its suppliers are reproduced exactly.

2 LICENSE RESTRICTIONS. Except as expressly permitted by this Agreement, Licensee shall not, nor permit anyone else to, directly or indirectly: (i) copy (except for one backup copy), modify, distribute or create derivative works based upon the Software; (ii) reverse engineer, disassemble, decompile or otherwise attempt to discover the source code or structure, sequence and organization of the Software; or (iii) rent, lease, or use the Software for timesharing or service bureau purposes, or otherwise use the Software for any commercial purpose/on behalf of any third party. Licensee shall maintain and not remove or obscure any proprietary notices on the Software, and shall reproduce such notices exactly on all permitted copies of the Software. All title, ownership rights, and intellectual property rights in and to the Software, and any copies or portions thereof, shall remain in Licensor and its suppliers or licensors. Licensee understands that Licensor may modify or discontinue offering the Software at any time. The Software is protected by the copyright laws of the United States and international copyright treaties. The Software is licensed, not sold. This Agreement does not give Licensee any rights not expressly granted herein.

3 INTELLECTUAL PROPERTY; CONTENT. All title and intellectual property rights in and to the Software (including but not limited to any images, photographs, animations, video, audio, music, text and "applets" incorporated into the Software), and any copies you are permitted to make
herein are owned by Licensor or its suppliers. All title and intellectual property rights in and to the content which may be accessed through use of the Software is the property of the respective content owner and may be protected by applicable copyright or other intellectual property laws and treaties. This EULA grants you no rights to use such content. As a condition to Licensee's use of the Software, Licensee represents, warrants and covenants that Licensee will not use the Software: (i) to infringe the intellectual property rights or proprietary rights, or rights of publicity or privacy, of any third party; (ii) to violate any applicable law, statute, ordinance or regulation; (iii) to disseminate information or materials in any form or format ("Content") that are harmful, threatening, abusive, harassing, tortuous, defamatory, vulgar, obscene, libelous, or otherwise objectionable; or (iv) to disseminate any software viruses or any other computer code, files or programs that may interrupt, destroy or limit the functionality of any computer software or hardware or telecommunications equipment. Licensee, not Licensor, remains solely responsible for all Content that Licensee uploads, posts, e-mails, transmits, or otherwise disseminates using, or in connection with, the Software.

4 FEES; SUPPORT AND UPGRADES. Licensor may, at Licensor's sole option, provide support services related to the Software ("Support Services"). Nothing in this Agreement grants Licensee any right to receive any Support Services. Use of any Support Services provided is governed by the Licensor policies and programs described in the user manual, in "online" documentation, and/or in other Licensor-provided materials or support agreements. Any supplemental software code provided to you as part of any Support Services shall be considered part of the Software and subject to the terms and conditions of this EULA. With respect to technical information you provide to Licensor as part of any Support Services, Licensor may use such information for its business purposes, including for product support and development. Licensor will not utilize such technical information in a form that personally identifies Licensee.

5 TERMINATION. Either party may terminate this Agreement at any time, with or without cause, upon written notice. Any termination of this Agreement shall also terminate the licenses granted hereunder. Upon termination of this Agreement for any reason, Licensee shall return all copies of the Software to Licensor, or destroy and remove from all computers, hard drives, networks, and other storage media all copies of the Software, and shall so certify to Licensor that such actions have occurred. Sections 2-13 shall survive termination of this Agreement.

6 DISCLAIMER OF WARRANTIES. To the maximum extent permitted by applicable law, Licensor and its suppliers provide the Software and any (if any) Support Services AS IS AND WITH ALL FAULTS, and hereby disclaim all warranties and conditions, either express, implied or statutory, including, but not limited to, any (if any) implied warranties or conditions of merchantability, of fitness for a particular purpose, of lack of viruses, of accuracy or completeness of responses, of results, and of lack of negligence or lack of workmanlike effort, all with regard to the Software, and the provision of or failure to provide Support Services. ALSO, THERE IS NO WARRANTY OR CONDITION OF TITLE, QUIET ENJOYMENT, QUIET POSSESSION, CORRESPONDENCE TO DESCRIPTION, OR NON-INFRINGEMENT WITH REGARD TO THE SOFTWARE. THE ENTIRE RISK AS TO THE QUALITY OF OR ARISING OUT OF USE OR PERFORMANCE OF THE SOFTWARE AND SUPPORT SERVICES, IF ANY, REMAINS WITH LICENSEE.
7 EXCLUSION OF INCIDENTAL, CONSEQUENTIAL AND CERTAIN OTHER DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL LICENSOR OR ITS SUPPLIERS BE LIABLE FOR ANY GENERAL, SPECIAL, INCIDENTAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF PROFITS OR CONFIDENTIAL OR OTHER INFORMATION, FOR BUSINESS INTERRUPTION, FOR PERSONAL INJURY, FOR LOSS OF PRIVACY, FOR FAILURE TO MEET ANY DUTY INCLUDING OF GOOD FAITH OR OF REASONABLE CARE, FOR NEGLIGENCE, AND FOR ANY OTHER PECUNIARY OR OTHER LOSS WHATSOEVER) ARISING OUT OF OR IN ANY WAY RELATED TO THE USE OF OR INABILITY TO USE THE SOFTWARE, THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES, OR OTHERWISE UNDER OR IN CONNECTION WITH ANY PROVISION OF THIS AGREEMENT, EVEN IN THE EVENT OF THE FAULT, TORT (INCLUDING NEGLIGENCE), STRICT LIABILITY, BREACH OF CONTRACT OR BREACH OF WARRANTY OF LICENSOR OR ANY SUPPLIER, AND EVEN IF LICENSOR OR ANY SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

8 LIMITATION OF LIABILITY AND REMEDIES. Notwithstanding any damages that Licensee might incur for any reason whatsoever (including, without limitation, all damages referenced above and all direct or general damages), the entire liability of Licensor and any of its suppliers under any provision of this Agreement and Licensee's exclusive remedy for all of the foregoing shall be limited to the greater of the amount actually paid by Licensee for the Software or U.S.$5.00. The foregoing limitations, exclusions and disclaimers shall apply to the maximum extent permitted by applicable law, even if any remedy fails its essential purpose.

9 INDEMNITY. Licensee agrees that Licensor shall have no liability whatsoever for any use Licensee makes of the Software. Licensee shall indemnify and hold harmless Licensor from any claims, damages, liabilities, costs and fees (including reasonable attorney fees) arising from Licensee's use of the Software as well as from Licensee's failure to comply with any term of this Agreement.

10 FAULT TOLERANCE. The Software is not fault-tolerant and is not designed, manufactured or intended for use or resale in on-line control equipment in hazardous environments requiring fail-safe performance, such as, but not limited to, the operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, life support machines, or weapons systems, in which the failure of the Software could lead directly or indirectly to death, personal injury, or physical or environmental damage ("High Risk Activities"). Licensor and its suppliers specifically disclaim any express or implied warranty of fitness for High Risk Activities.

11 U.S. GOVERNMENT LICENSE RIGHTS. Software provided to the U.S. Government pursuant to solicitations issued on or after December 1, 1995 is provided with the commercial license rights and restrictions described elsewhere herein. Software provided to the U.S. Government pursuant to solicitations issued prior to December 1, 1995 is provided with "Restricted Rights" as provided for in FAR, 48 CFR 52.227-14 (JUNE 1987) or DFAR, 48 CFR 252.227-7013 (OCT 1988), as applicable. The "Manufacturer" for purposes of these regulations is Symbol Technologies, Inc., One Symbol Plaza, Holtsville, NY 11742.

12 EXPORT RESTRICTIONS. Licensee shall comply with all export laws and restrictions and regulations of the Department of Commerce, the United States Department of Treasury Office of
Foreign Assets Control ("OFAC"), or other United States or foreign agency or authority, and Licensee shall not export, or allow the export or re-export of the Software in violation of any such restrictions, laws or regulations. By downloading or using the Software, Licensee agrees to the foregoing and represents and warrants that Licensee is not located in, under the control of, or a national or resident of any restricted country.

13 MISCELLANEOUS. Licensee may not sublicense, assign, or transfer this Agreement, or its rights or obligations hereunder, without the prior written consent of Licensor. Any attempt to otherwise sublicense, assign, or transfer any of the rights, duties, or obligations hereunder is null and void. Licensor may assign this Agreement in its sole discretion. In the event that any of the provisions of this Agreement shall be held by a court or other tribunal of competent jurisdiction to be illegal, invalid or unenforceable, such provisions shall be limited or eliminated to the minimum extent necessary so that this Agreement shall otherwise remain in full force and effect. No waiver or modification of this Agreement will be binding upon a party unless made in writing and signed by a duly authorized representative of such party and no failure or delay in enforcing any right will be deemed a waiver. This Agreement shall be governed by the laws of the State of New York without regard to the conflicts of law provisions thereof. The application the United Nations Convention of Contracts for the International Sale of Goods is expressly excluded. Unless waived by Licensor for a particular instance, any action or proceeding arising out of this Agreement must be brought exclusively in the state or federal courts of New York and Licensee hereby consents to the jurisdiction of such courts for any such action or proceeding. This Agreement supersedes all prior discussions and writings and constitutes the entire agreement between the parties with respect to the subject matter hereof. The prevailing party in any action arising out of this Agreement shall be entitled to costs and attorneys' fees.